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10GBASE-KR Compliance Test Application—At a Glance
The Keysight D9010EAPC 10GBASE-KR Compliance Test Application is an 
Ethernet test solution that covers the electrical timing parameters for 
10GBASE-KR and 40GBASE-KR4 specification (IEEE 802.3ap).

The 10GBASE-KR Compliance Test Application:

• Lets you select individual or multiple test to run.

• Lets you identify the device being tested and its configuration.

• Shows you how to make oscilloscope connections to the device under test.

• Automatically checks for proper oscilloscope configuration.

• Automatically sets up the oscilloscope for each test.

• Allows you to determine the number of trials for each test.

• Provides detailed information of each test that has been run. The result of 
maximum 25 worst trials can be displayed at any one time.

• Creates a printable HTML report of the tests that have been run. This report 
includes pass/fail limits, margin analysis, and screen shots.

Required
Equipment and

Software

In order to run the 10GBASE-KR automated tests, you need the following 
equipment and software:

• For the minimum version of Infiniium oscilloscope software, see the 
D9010EAPC release notes.

• D9010EAPC 10GBASE-KR Compliance Test Application software and license.

• For differential probing (minimum 25 GHz):

• N2802A 25 GHz InfiniiMax III Series probe amplifier.

• N2803A 30 GHz InfiniiMax III Series probe amplifier.

• N2836A InfiniiMax III 26 GHz solder-in probe head.

• For single-ended probing:

• SMA cables that are able to support the 10 Gb speed.

• Infiniium oscilloscope:

• DSA-X 90000 Q-Series oscilloscope

• DSA-X 90000A Series oscilloscope

• DSO-X 90000 Q-Series oscilloscope

• DSO-X 90000A Series oscilloscope

• UXR Series oscilloscope 
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1 Installing the 10GBASE-KR 
Compliance Test Application

Installing the Software / 10
Installing the License Key / 11

If you purchased the D9010EAPC 10GBASE-KR Compliance Test Application 
separate from your Infiniium oscilloscope, you need to install the software and 
license key.
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1 Installing the 10GBASE-KR Compliance Test Application
 

Installing the Software

1 Make sure you have the minimum version of Infiniium oscilloscope software 
(see the D9010EAPC release notes) by choosing Help > About Infiniium... from the 
main menu.

2 To obtain the 10GBASE-KR Compliance Test Application, go to Keysight 
website: http://www.keysight.com/find/D9010EAPC

3 The link for 10GBASE-KR Compliance Test Application will appear. 
Double-click on it and follow the instructions to download and install the 
application software.

http://www.keysight.com/find/D9010EAPC
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Installing the License Key

For the list of licenses required to run this application, refer to the Data Sheet.

To procure a license, you require the Host ID information that is displayed in the 
Keysight License Manager application installed on the same machine where you 
wish to install the license.

Using Keysight License Manager 5

To view and copy the Host ID from Keysight License Manager 5:

1 Launch Keysight License Manager on your machine, where you wish to run the 
Test Application and its features.

2 Copy the Host ID that appears on the top pane of the application. Note that x 
indicates numeric values.

Figure 1 Viewing the Host ID information in Keysight License Manager 5

To install one of the procured licenses using Keysight License Manager 5 
application,

1 Save the license files on the machine, where you wish to run the Test 
Application and its features.

2 Launch Keysight License Manager.

3 From the configuration menu, use one of the options to install each license file.

Figure 2 Configuration menu options to install licenses on Keysight License Manager 5
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1 Installing the 10GBASE-KR Compliance Test Application
 

For more information regarding installation of procured licenses on Keysight 
License Manager 5, refer to Keysight License Manager 5 Supporting 
Documentation.

Using Keysight License Manager 6

To view and copy the Host ID from Keysight License Manager 6:

1 Launch Keysight License Manager 6 on your machine, where you wish to run 
the Test Application and its features.

2 Copy the Host ID, which is the first set of alphanumeric value (as highlighted in 
Figure 3) that appears in the Environment tab of the application. Note that x 
indicates numeric values.

Figure 3 Viewing the Host ID information in Keysight License Manager 6

To install one of the procured licenses using Keysight License Manager 6 
application,

1 Save the license files on the machine, where you wish to run the Test 
Application and its features.

2 Launch Keysight License Manager 6.

3 From the Home tab, use one of the options to install each license file.

https://www.keysight.com/main/redirector.jspx?action=ref&nid=-33002.0.00&lc=eng&cc=IN&ckey=2953922&cname=EDITORIAL&nfr=-33002.0.02
https://www.keysight.com/main/redirector.jspx?action=ref&nid=-33002.0.00&lc=eng&cc=IN&ckey=2953922&cname=EDITORIAL&nfr=-33002.0.02
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Figure 4 Home menu options to install licenses on Keysight License Manager 6

For more information regarding installation of procured licenses on Keysight 
License Manager 6, refer to Keysight License Manager 6 Supporting 
Documentation.

https://www.keysight.com/main/redirector.jspx?action=obs&nid=-33002.0.00&lc=eng&cc=IN&ckey=2994142&pubno=&ltype=LitStation&ctype=EDITORIAL&nfr=-33002.0.02
https://www.keysight.com/main/redirector.jspx?action=obs&nid=-33002.0.00&lc=eng&cc=IN&ckey=2994142&pubno=&ltype=LitStation&ctype=EDITORIAL&nfr=-33002.0.02
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1 Installing the 10GBASE-KR Compliance Test Application
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2 Preparing to Take 
Measurements

Calibrating the Oscilloscope / 16
Starting the 10GBASE-KR Compliance Test Application / 17

Before running the 10GBASE-KR and 40GBASE-KR4 automated tests, you should 
calibrate the oscilloscope and probe. No test fixture is required for this application. 
After the oscilloscope and probe have been calibrated, you are ready to start the 
10GBASE-KR Compliance Test Application and perform the measurements.
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2 Preparing to Take Measurements
 

Calibrating the Oscilloscope

If you haven't already calibrated the oscilloscope, see Appendix A, “Calibrating the 
Infiniium Oscilloscope and Probe,” starting on page 103.

NOTE If the ambient temperature changes more than 5 degrees Celsius from the calibration 
temperature, internal calibration should be performed again. The delta between the 
calibration temperature and the present operating temperature is shown in the Utilities > 
Calibration menu.

NOTE If you switch cables between channels or other oscilloscopes, it is necessary to perform cable 
and probe calibration again. Keysight recommends that, once calibration is performed, you 
label the cables with the channel on which they were calibrated.
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Starting the 10GBASE-KR Compliance Test Application

1 Ensure that the Device Under Test (DUT) is operating and set to desired test 
modes.

2 To start the 10GBASE-KR Compliance Test Application: From the Infiniium 
oscilloscope's main menu, choose Analyze > Automated Test Apps > D9010EAPC 
10GKR 40GKR Test App.

Figure 5 10GBASE-KR Compliance Test Application Main Window

The tabs in the main pane show the steps you take in running the automated tests:
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2 Preparing to Take Measurements
 

Set Up Lets you identify and set up the test environment, including information 
about the device under test.
The Instrument Setup section enables you to configure switch matrix.
Set up InfiniiSim with the InfiniiSim Setup button.
With the Set Channel skew button, the channels can be visually adjusted 
and skewed.
The Saved Waveform Setup button enables easy setup of saved 
waveforms. When waveforms are set up, the application will make all 
measurements on the saved waveforms. 
The Device Identifier, User Description, and Comments are all printed in 
the final HTML report.

Select Tests Lets you select the tests you want to run. The tests are organized 
hierarchically so you can select all tests in a group. After tests are run, 
status indicators show which tests have passed, failed, or not been run, 
and there are indicators for the test groups.

Configure Lets you configure test parameters (for example, channels used in test, 
Number of UI to test, scope bandwidth, etc.).

Connect Shows you how to connect the oscilloscope to the device under test for 
the tests that are to be run.

Run Tests Starts the automated tests. If the connections to the device under test 
need to be changed while multiple tests are running, the tests pause, show 
you how to change the connection, and wait for you to confirm that the 
connections have been changed before continuing.

Automation Lets you construct scripts of commands that drive execution of the 
application.

Results Contains more detailed information about the tests that have been run. You 
can change the thresholds at which marginal or critical warnings appear.

HTML Report Shows a compliance test report that can be printed.



19

 

Keysight D9010EAPC 10GBASE-KR and 40GBASE-KR4 Compliance Test Application 
Methods of Implementation

3 Setting Up to Test 
40GBASE-KR4 with Switch 
Matrix

Overview / 20
Enabling Switch Matrix / 21
Establishing Connection to the Switch Drivers / 22
Configuring Signal Paths / 30
Response Correction / 32

40GBASE-KR4 tests can run with the switch matrix using four dual single-ended 
connections or without the switch matrix using four differential probe connections. 
Without switch matrix requires the Infiniimax III probe: N2802A or N2803A.

Both options are fully automated to switch across the four lanes. Switch Matrix 
requires either the Keysight U3020A S26 or the BitifEye BIT2100.

If differential Infiniimax III probes are used, 40GBASE-KR4 tests can be run without 
the switch matrix. The four lanes can be connected to channels 1 through 4. 

This chapter describes the switch matrix feature and steps for configuring the 
switch matrix in the Keysight D9010EAPC 10GBASE-KR and 40GBASE-KR4 
Compliance Test Application.
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3 Setting Up to Test 40GBASE-KR4 with Switch Matrix
 

Overview

An Oscilloscope has only four Channels to run tests. The limited number of 
channels may, at times, limit the testing of some multi-lane standards. Also, it may 
prove to be a hindrance to run test procedures for multi-port devices or 
simultaneous testing of multiple devices. The Switch Matrix feature on the 
Infiniium Oscilloscope overcomes such limitations. 

The purpose of the ‘Switch Matrix’ feature is to ease the testing procedure, make it 
more feasible and to reduce the overall time. Using this feature, you can connect 
multiple lanes of the source devices to the correct switches and to obtain an 
accurate signal path whenever required.

Keysight recommends the following switches to be used with the Test Application:

• Keysight U3020A S26

• BitifEye BIT-2100

The following figure shows the connection setup for 40GBASE-KR4 tests with the 
switch matrix.
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Enabling Switch Matrix

Before you begin the testing of multiple lane pairs of the source devices 
simultaneously, you must enable the Switch Matrix feature.

To enable the switch matrix feature:

1 Click Tools>Switch Matrix....

2 In the Configure Switch Matrix Settings dialog box, click On to enable the Switch 
Matrix feature.

Enabling the Switch Matrix feature also enables the automated switch control. The 
option Automatically select drivers and paths (limited models) in the Configuration Mode 
section of the Controller tab is selected by default.
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3 Setting Up to Test 40GBASE-KR4 with Switch Matrix
 

Establishing Connection to the Switch Drivers

Establishing connection to the Switch Drivers — Automatically

In the Configure Switch Matrix Settings dialog, under the Controller tab:

1 From the Switch Drivers section, select the switch model from the Model: 
drop-down options.

2 Click the Connect button to be able to connect the selected switch driver to a 
physical switch instrument.

3 A Connect to <switch-model> dialog appears, which gives you two options to 
establish a connection to the selected switch models.

4 Select one of the options to establish connection:

NOTE The switch settings and the response correction for all paths are reset if you 
toggle between switch models.
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Selecting Enter/Select VISA address/alias

1 Select Enter/Select VISA address/alias to type the complete SICL or VISA address 
of the switch driver. By default, this option is selected.

2 Click the Get button to identify the instrument at the specified address or alias 
and to view the current status of the instrument that is connected to the switch 
driver.

3 Click OK to return to the Configure Switch Matrix Settings dialog. The connection 
to the selected switch is displayed.



24 Keysight D9010EAPC 10GBASE-KR and 40GBASE-KR4 Compliance Test Application

3 Setting Up to Test 40GBASE-KR4 with Switch Matrix
 

4 Click OK to save the settings and return to the test environment.

Selecting from Keysight Connection Expert favorites

1 Choose Select from Keysight Connection Expert favorites to control the application 
with the help of remote PC. Upon selecting this option, the application starts 
seeking device information from the Keysight Connection Expert.
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If remote access of the device is enabled, the Connect to <switch-model> dialog 
displays the list of active instruments.

2 Click to select the Identify / Hide unresponsive addresses check box to run an IDN 
query to every instrument in the list and search for the active instruments, if 
any.
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3 Setting Up to Test 40GBASE-KR4 with Switch Matrix
 

3 If any active instruments are found, the Connect to <switch-model> dialog lists 
out such instruments. Select the required instrument from the list.

4 Click OK to return to the Configure Switch Matrix Settings dialog. The connection 
to the selected switch is displayed.

5 Click OK in the Configure Switch Matrix Settings dialog to save the settings and 
return to the test environment.

Establishing connection to the Switch Drivers — Manually

The Manually perform these tasks (any supported model) option allows you to decide 
how many drivers to use and how to route the signal paths. It enables the use of 
any supported switch model.

NOTE The Select from Keysight Connection Expert favorites option is available 
only when the device is powered on and enabled for remote access. 
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In the Configure Switch Matrix Settings dialog:

1 Click to select the Manually perform these tasks (any supported model) radio button 
in the Configuration Mode section.

2 From the Switch Drivers section, select the switch model from the Model: 
drop-down options.

3 In the Switch Drivers section, you may use the Add button to append the list of 
any additional drivers, which require a connection to an instrument. Use the 
Delete button to remove a selected driver from the list. Removing the driver 
from the list dissociates any signal paths that may have been assigned to it 
earlier.
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3 Setting Up to Test 40GBASE-KR4 with Switch Matrix
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4 When you click the Add... button, the Connect... button appears so that you can 
establish connectivity to the selected Switch. 

5 The rest of the steps for establishing a connection to the switch model remains 
the same as described in the previous section. The only difference between 
automatic and manual modes is that you can add/delete and select switch 
drivers (any supported model) as per your requirements and preferences in the 
manual mode.
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3 Setting Up to Test 40GBASE-KR4 with Switch Matrix
 

Configuring Signal Paths

Once you have enabled the Switch Matrix feature and set up connections to the 
switch drivers, you must configure signal paths. The options to configure the signal 
paths vary depending upon whether you have selected Automatically select drivers 
and paths (limited models) or Manually perform these tasks (any supported model) in the 
Controller tab of the Configure Switch Matrix Settings dialog.

Refer to the connection diagram before configuring signal paths either for 
Automatic or Manual selection. Under the Controller tab, click the Connection Guide 
button to access the Connection Diagram dialog.

Configuring Signal Paths with Automatic Selection

When you have selected Automatically select drivers and paths (limited models) in the 
Controller tab of the Configure Switch Matrix Settings dialog:

1 Click the Signal Paths tab. The Path Assignment table lists the connection matrix 
of the device with the Switch modules.

2 Scroll down to view the automatic connections that have been established.

At runtime, when the Switch Matrix module is on and when a connection prompt 
occurs, two events occur:

• The framework suppresses the prompts.

• The Switch Matrix module detects the new connection and then throw 
switches, as indicated in the Switch column, taking into account the current 
value of the configuration variable (if any) associated with the connection.

Configuring Signal Paths with Manual Selection

When you have selected Manually perform these tasks (any supported model) in the 
Controller tab of the Configure Switch Matrix Settings dialog:

1 Click the Signal Paths tab in the Configure Switch Matrix Settings dialog.

2 Select the channel or switch module in one of the drop-down options. Manually 
select the alternative channel or driver module from the other drop-down 
option.

3 Optionally, you may change the lane assignments and the corresponding 
Switch modules.

4 Click the View Connections... button to view the signal path mapping, to 
understand how the signal path maps to the connection diagrams being used 
by the application.

5 The Signal Paths Connection View dialog is displayed. Select any one of the 
available options in the Connection: drop-down.
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6 The Path Assignment & Response Correction area displays the connections 
configured for the corresponding connection diagrams in the Connection: 
drop-down.

7 Select an entry in the Path Assignment & Response Correction area to view the 
corresponding test information.

8 Click the Tests... button to view information about the tests that use the 
selected connection to perform automated tests.

9 Click the Close button to exit and return to the Configure Switch Matrix Settings 
dialog to finish the signal path configuration.

10 If required, use the Reset Paths... button to clear all switch and response 
correction settings for all paths. Click OK if you wish to proceed.

11 Also, if needed, use the Load Preconfigured Settings... button to set switches for all 
paths as per the recommended settings. Click OK if you wish to proceed.
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3 Setting Up to Test 40GBASE-KR4 with Switch Matrix
 

Response Correction

You must specify the response correction after you finish configuring the signal 
paths. Configuring this area is vital as it impacts the measurement accuracy, 
credibility and performance of the Oscilloscope. The purpose of response 
correction is to correct the channel frequency response of the oscilloscope.

For each scope channel that you select, the default response correction method is 
None, which turns off normalization for the specified path. 

You may use the Edit Settings button or double-click the selected row to access the 
corresponding configuration dialog, if you wish to make further changes to a 
specific scope channel configuration.

Use the Execute Switches button to establish a connection between the selected 
test point and scope channel. The color of this button corresponds to the 
Oscilloscope Channel where the Switch is connected to.
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In the following example, the application displays the prompt indicating that a 
connection is established when you click Execute Switches after selecting the first 
row. Click OK to close the prompt.

Once you have finished response corrections for all connections, click OK in the 
Configure Switch Matrix Settings dialog. The application redirects you to the test 
environment.
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3 Setting Up to Test 40GBASE-KR4 with Switch Matrix
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4 Main Voltage Measurements

Differential Peak-to-Peak Output Voltage Test with TX Disabled / 39
Common Mode Voltage Test / 40
Differential Peak-to-Peak Output Voltage Test / 41

This section provides the Methods of Implementation (MOIs) for the Main Voltage 
Measurements using a Keysight Infiniium oscilloscope and the D9010EAPC 
10GBASE-KR Compliance Test Application.
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4 Main Voltage Measurements
 

Probing and
Connection for the

Bus Signal Level
Tests

You can use any of the oscilloscope channels as the signal source channel. You 
can identify the channels used for the measurement signal in the Configuration tab 
of the 10GBASE-KR Compliance Test Application. (The channels shown in the 
previous figure are just an example.)

Figure 6 Probing for Main Voltage Measurements



Main Voltage Measurements 4

Keysight D9010EAPC 10GBASE-KR and 40GBASE-KR4 Compliance Test Application 37

 

Test Procedure 1 Start the automated test application as described in "Starting the 
10GBASE-KR Compliance Test Application" on page 17.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope 
that you have set up in the Configuration tab.

4 In the 10GBASE-KR Test application, click on the Set Up tab.

5 Set up InfiniiSim if needed.

6 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

7 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

Figure 7 Selecting Main Voltage Measurement Tests
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4 Main Voltage Measurements
 

Main Voltage
Specifications

The 10GBASE-KR and 40GBASE-KR4 specifications can be found in IEEE 802.3ap 
section 72.7.1.

• Differential Peak-to-Peak Output Voltage with TX disabled (max 30 mV).

• Common Mode Voltage (0-1.9 V).

• Differential Peak-to-Peak Output Voltage (max 1200 mV).
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Differential Peak-to-Peak Output Voltage Test with TX Disabled

The purpose of this test is to verify that when TX is disabled the peak-to-peak 
voltage is less than 30 mV.

PASS Condition The max peak-to-peak voltage is less than 30 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that the signal is truly disabled (no valid data transitions).

3 Measure peak-to-peak voltage of the signal.

4 Compare the max peak-to-peak voltage to 30 mV.
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4 Main Voltage Measurements
 

Common Mode Voltage Test

The purpose of this test is to verify that the common mode signal of the differential 
pair is between 0-1.9 V.

PASS Condition The signal is between 0-1.9 V.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal and that the connection is dual-single ended.

3 Measure the Vmin and Vmax of the addition of the channel 1 and 3 or channel 2 
and 4.

4 Compare the worst result measurement to 0-1.9 V.

NOTE This measurement can be done only with dual-single ended connection; it cannot be done 
with a differential probing connection.
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Differential Peak-to-Peak Output Voltage Test

The purpose of this test is to verify that the peak-to-peak voltage of the differential 
signal on a 1010 pattern is less than 1200 mV.

PASS Condition The differential signal max peak-to-peak voltage on a 1010 pattern is less than 
1200 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal is connected and has a 1010 pattern.

3 Measure the peak-to-peak voltage of the differential signal of DUT+ and DUT-.

4 Compare the max peak-to-peak voltage to 1200 mV.
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4 Main Voltage Measurements
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Keysight D9010EAPC 10GBASE-KR and 40GBASE-KR4 Compliance Test Application 
Methods of Implementation

5 Jitter and Data Rate 
Measurements

Data Rate / 46
Jitter (Random Jitter, Deterministic Jitter, Duty Cycle Distortion, and Total Jitter) / 47

This section provides the Methods of Implementation (MOIs) for the Jitter and 
Data Rate Measurements using a Keysight Infiniium oscilloscope and the 
D9010EAPC 10GBASE-KR Compliance Test Application.
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5 Jitter and Data Rate Measurements
 

Probing and
Connection for the

Bus Signal Level
Tests

You can use any of the oscilloscope channels as the signal source channel. You 
can identify the channels used for the measurement signal in the Configuration tab 
of the 10GBASE-KR Compliance Test Application. (The channels shown in the 
previous figure are just an example.)

Test Procedure 1 Start the automated test application as described in "Starting the 
10GBASE-KR Compliance Test Application" on page 17.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope 
that you have set up in the Configuration tab.

4 In the 10GBASE-KR and 40GBASE-KR4 Test application, click on the Set Up 
tab.

5 Set up InfiniiSim if needed.

6 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

Figure 8 Probing for Jitter and Data Rate Measurements
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7 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

Figure 9 Selecting Jitter and Data Rate Tests

Transmitter Output
Waveform

Specifications

The 10GBASE-KR and 40GBASE-KR4 specifications can be found in IEEE 802.3ap 
section 72.7.1.

• Data Rate (10.3125 ±100 ppm GBd).

• Max output jitter (max peak-to-peak).

• Random Jitter (max 150 mUI).

• Deterministic Jitter (max 150 mUI).

• Duty Cycle Distortion (max 35 mUI).

• Total Jitter (max 280 mUI).



46 Keysight D9010EAPC 10GBASE-KR and 40GBASE-KR4 Compliance Test Application

5 Jitter and Data Rate Measurements
 

Data Rate

The purpose of this test is to verify that the data rate mean is between 10.3125 
±100 ppm.

PASS Condition The mean data rate is between 10.3125 ±100 ppm.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that the signal is connected and data pattern exists (pattern 2 or 3 must 
be used for this test).

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Set data rate measurement to semi-automatic 10.3125 Gb/s.

5 Measure min, max, mean data rate.

6 Report min and max values.

7 Compare and report the mean data rate value to 10.3125 ±100 ppm GBd.



Jitter and Data Rate Measurements 5

Keysight D9010EAPC 10GBASE-KR and 40GBASE-KR4 Compliance Test Application 47

 

Jitter (Random Jitter, Deterministic Jitter, Duty Cycle Distortion, and 
Total Jitter)

The purpose of this test is to verify that differential signal's Random Jitter is less 
than 150 mUI, Deterministic Jitter is less than 150 mUI, Duty Cycle Distortion is 
less than 35 mUI, and Total Jitter is less than 280 mUI. If all tests are selected, all 
tests are run on a single measurement. Each test can be run individually by 
selecting any or some of the tests.

PASS Conditions • Random Jitter rms is less than 150 mUI.

• Deterministic p-p jitter is less than 150 mUI.

• Duty Cycle Distortion is less than 35 mUI.

• Total Jitter at BER of 10E-12 is less than 280 mUI.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that the signal is connected and data pattern exists (pattern 2 or 3 must 
be used for all the tests other than Duty Cycle Distortion. For Duty Cycle 
Distortion, pattern 1010 must be used).

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Set clock recovery to OJTF First Order PLL with Nominal Data Rate 
10.3125 Gb/s and Loop Bandwidth to 4 MHz.

5 Using EZJIT, measure Random Jitter, Deterministic Jitter, Duty Cycle 
Distortion, and Total Jitter at BER of 10E-12.

6 Compare and report the values to their respective maximum specification.
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5 Jitter and Data Rate Measurements
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Keysight D9010EAPC 10GBASE-KR and 40GBASE-KR4 Compliance Test Application 
Methods of Implementation

6 Transmitter Output Waveform 
Measurements

Transition Time - Rising Edge / 52
Transition Time - Falling Edge / 53

This section provides the Methods of Implementation (MOIs) for the Transmitter 
Output Waveform Measurements for Transition Time using a Keysight Infiniium 
oscilloscope and the D9010EAPC 10GBASE-KR Compliance Test Application.
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6 Transmitter Output Waveform Measurements
 

Probing and
Connection for the

Bus Signal Level
Tests

You can use any of the oscilloscope channels as the signal source channel. You 
can identify the channels used for the measurement signal in the Configuration tab 
of the 10GBASE-KR Compliance Test Application. (The channels shown in the 
previous figure are just an example.)

Test Procedure 1 Start the automated test application as described in "Starting the 
10GBASE-KR Compliance Test Application" on page 17.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope 
that you have set up in the Configuration tab.

4 In the 10GBASE-KR Test application, click on the Set Up tab.

5 Set up InfiniiSim if needed.

6 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

Figure 10 Probing for Transmitter Output Waveform Measurements
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7 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

Figure 11 Selecting Transmitter Output Waveform Test

Data Rate and
Jitter

Specifications

The 10GBASE-KR and 40GBASE-KR4 specifications can be found in IEEE 802.3ap 
section 72.7.1.

• Transition Time (20%-80%) – Rising Edge (24-47 ps).

• Transition Time (20%-80%) – Falling Edge (24-47 ps).
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6 Transmitter Output Waveform Measurements
 

Transition Time - Rising Edge

The purpose of this test is to verify that the rising edge of the differential signal is 
between 24 to 47 ps.

PASS Condition The min and max rise time of the signal are between 24 to 47 ps.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that the signal is connected and data pattern exists (square 8 pattern).

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Measure min and max rise time of the entire signal.

5 Compare and report the min and max values to the valid range of 24-47 ps.
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Transition Time - Falling Edge

The purpose of this test is to verify that the falling edge of the differential signal is 
between 24 to 47 ps.

PASS Condition The min and max fall time of the signal are between 24 to 47 ps.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that the signal is connected and data pattern exists (square 8 pattern).

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Measure min and max fall time of the entire signal.

5 Compare and report the min and max values to the valid range of 24-47 ps.
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6 Transmitter Output Waveform Measurements
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Keysight D9010EAPC 10GBASE-KR and 40GBASE-KR4 Compliance Test Application 
Methods of Implementation

7 Transmitter Output Waveform 
- Coefficient Update 
Measurements

Coefficient Update c_1 inc c_0 hold c_1 hold / 59
Coefficient Update c_1 dec c_0 hold c_1 hold / 60
Coefficient Update c_1 hold c_0 inc c_1 hold / 61
Coefficient Update c_1 hold c_0 dec c_1 hold / 62
Coefficient Update c_1 hold c_0 hold c_1 inc / 63
Coefficient Update c_1 hold c_0 hold c_1 dec / 64

This section provides the Methods of Implementation (MOIs) for the Transmitter 
Output Waveform Coefficient Update Measurements using a Keysight Infiniium 
oscilloscope and the D9010EAPC 10GBASE-KR Compliance Test Application.
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7 Transmitter Output Waveform - Coefficient Update Measurements
 

Probing and
Connection for the

Bus Signal Level
Tests

You can use any of the oscilloscope channels as the signal source channel. You 
can identify the channels used for the measurement signal in the Configuration tab 
of the 10GBASE-KR Compliance Test Application. (The channels shown in the 
previous figure are just an example.)

Test Procedure 1 Start the automated test application as described in "Starting the 
10GBASE-KR Compliance Test Application" on page 17.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope 
that you have set up in the Configuration tab.

4 In the 10GBASE-KR Test application, click on the Set Up tab.

5 Set up InfiniiSim if needed.

6 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

Figure 12 Probing for Transmitter Output Waveform – Coefficient Update Measurements
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7 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

Figure 13 Selecting Transmitter Output Waveform – Coefficient Update Test

Coefficient Update
Specifications

The 10GBASE-KR and 40GBASE-KR4 specifications can be found in IEEE 802.3ap 
section 72.7.1.11 – Table 72-7.

Coefficient Update Requirements

c(1) c(0) c(–1) v1(k) – v1(k – 
1) (mV)

v2(k) – v2(k – 
1) (mV)

v3(k) – v3(k – 
1) (mV)

increment hold hold –20 to –5 5 to 20 5 to 20

decrement hold hold 5 to 20 –20 to –5 –20 to –5

hold increment hold 5 to 20 5 to 20 5 to 20

hold decrement hold –20 to –5 –20 to –5 –20 to –5
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7 Transmitter Output Waveform - Coefficient Update Measurements
 

hold hold increment 5 to 20 5 to 20 –20 to –5

hold hold decrement –20 to –5 –20 to –5 5 to 20

Coefficient Update Requirements

c(1) c(0) c(–1) v1(k) – v1(k – 
1) (mV)

v2(k) – v2(k – 
1) (mV)

v3(k) – v3(k – 
1) (mV)
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Coefficient Update c_1 inc c_0 hold c_1 hold

The purpose of this test is to verify that the difference in v1, v2, and v3 between 
coefficient updates, falls between the specified values in table 72-7 of IEEE 
802.3ap.

PASS Condition The difference in the coefficient update when c(1) is incremented to the previous 
state for v1, v2, and v3 are within the specified values.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that the signal is connected and data pattern exists (square 8 pattern).

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Measure v1 – set measurement to measure Voltage Overshoot on the rising 
edge.

5 Measure v2 – set measurement to measure Pulse Top with Pulse width of 50%.

6 Measure v3 – set measurement to measure Voltage Preshoot on the falling 
edge.

7 Save v1, v2, v3 as v1(k-1), v2(k-1), and v3(k-1) values.

8 Pop up to ask user to Increment c(1). OK pressed.

9 Measure v1 – set measurement to measure Voltage Overshoot on the rising 
edge.

10 Measure v2 – set the measurement to measure Pulse Top with Pulse width of 
50%.

11 Measure v3 – set measurement to measure Voltage Preshoot on the falling 
edge.

12 Subtract v1(k) – v1(k-1), v2(k)-v2(k-1), and v3(k)-v3(k-1).

13 Compare and report the values from step 12 to their respective value ranges in 
table 72-7 of IEEE 802.3ap.
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7 Transmitter Output Waveform - Coefficient Update Measurements
 

Coefficient Update c_1 dec c_0 hold c_1 hold

The purpose of this test is to verify that the difference in v1, v2, and v3 between 
coefficient updates, falls between the specified values in table 72-7 of IEEE 
802.3ap.

PASS Condition The difference in the coefficient update when c(1) is decremented to the previous 
state for v1, v2, and v3 are within the specified values.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that the signal is connected and data pattern exists (square 8 pattern).

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Measure v1 – set measurement to measure Voltage Overshoot on the rising 
edge.

5 Measure v2 – set measurement to measure Pulse Top with Pulse width of 50%.

6 Measure v3 – set measurement to measure Voltage Preshoot on the falling 
edge.

7 Save v1, v2, v3 as v1(k-1), v2(k-1), and v3(k-1) values.

8 Pop up to ask user to decrement c(1). OK pressed.

9 Measure v1 – set measurement to measure Voltage Overshoot on the rising 
edge.

10 Measure v2 – set the measurement to measure Pulse Top with Pulse width of 
50%.

11 Measure v3 – set measurement to measure Voltage Preshoot on the falling 
edge.

12 Subtract v1(k) – v1(k-1), v2(k)-v2(k-1), and v3(k)-v3(k-1).

13 Compare and report the values from step 12 to their respective value ranges in 
table 72-7 of IEEE 802.3ap.
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Coefficient Update c_1 hold c_0 inc c_1 hold

The purpose of this test is to verify that the difference in v1, v2, and v3 between 
coefficient updates, falls between the specified values in table 72-7 of IEEE 
802.3ap.

PASS Condition The difference in the coefficient update when c(0) is incremented to the previous 
state for v1, v2, and v3 are within the specified values.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that the signal is connected and data pattern exists (square 8 pattern).

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Measure v1 – set measurement to measure Voltage Overshoot on the rising 
edge.

5 Measure v2 – set measurement to measure Pulse Top with Pulse width of 50%.

6 Measure v3 – set measurement to measure Voltage Preshoot on the falling 
edge.

7 Save v1, v2, v3 as v1(k-1), v2(k-1), and v3(k-1) values.

8 Pop up to ask user to Increment c(0). OK pressed.

9 Measure v1 – set measurement to measure Voltage Overshoot on the rising 
edge.

10 Measure v2 – set the measurement to measure Pulse Top with Pulse width of 
50%.

11 Measure v3 – set measurement to measure Voltage Preshoot on the falling 
edge.

12 Subtract v1(k) – v1(k-1), v2(k)-v2(k-1), and v3(k)-v3(k-1).

13 Compare and report the values from step 12 to their respective value ranges in 
table 72-7 of IEEE 802.3ap.
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7 Transmitter Output Waveform - Coefficient Update Measurements
 

Coefficient Update c_1 hold c_0 dec c_1 hold

The purpose of this test is to verify that the difference in v1, v2, and v3 between 
coefficient updates, falls between the specified values in table 72-7 of IEEE 
802.3ap.

PASS Condition The difference in the coefficient update when c(0) is decremented to the previous 
state for v1, v2, and v3 are within the specified values.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that the signal is connected and data pattern exists (square 8 pattern).

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Measure v1 – set measurement to measure Voltage Overshoot on the rising 
edge.

5 Measure v2 – set measurement to measure Pulse Top with Pulse width of 50%.

6 Measure v3 – set measurement to measure Voltage Preshoot on the falling 
edge.

7 Save v1, v2, v3 as v1(k-1), v2(k-1), and v3(k-1) values.

8 Pop up to ask user to decrement c(0). OK pressed.

9 Measure v1 – set measurement to measure Voltage Overshoot on the rising 
edge.

10 Measure v2 – set the measurement to measure Pulse Top with Pulse width of 
50%.

11 Measure v3 – set measurement to measure Voltage Preshoot on the falling 
edge.

12 Subtract v1(k) – v1(k-1), v2(k)-v2(k-1), and v3(k)-v3(k-1).

13 Compare and report the values from step 12 to their respective value ranges in 
table 72-7 of IEEE 802.3ap.
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Coefficient Update c_1 hold c_0 hold c_1 inc

The purpose of this test is to verify that the difference in v1, v2, and v3 between 
coefficient updates, falls between the specified values in table 72-7 of IEEE 
802.3ap.

PASS Condition The difference in the coefficient update when c(-1) is incremented to the previous 
state for v1, v2, and v3 are within the specified values.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that the signal is connected and data pattern exists (square 8 pattern).

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Measure v1 – set measurement to measure Voltage Overshoot on the rising 
edge.

5 Measure v2 – set measurement to measure Pulse Top with Pulse width of 50%.

6 Measure v3 – set measurement to measure Voltage Preshoot on the falling 
edge.

7 Save v1, v2, v3 as v1(k-1), v2(k-1), and v3(k-1) values.

8 Pop up to ask user to increment c(-1). OK pressed.

9 Measure v1 – set measurement to measure Voltage Overshoot on the rising 
edge.

10 Measure v2 – set the measurement to measure Pulse Top with Pulse width of 
50%.

11 Measure v3 – set measurement to measure Voltage Preshoot on the falling 
edge.

12 Subtract v1(k) – v1(k-1), v2(k)-v2(k-1), and v3(k)-v3(k-1).

13 Compare and report the values from step 12 to their respective value ranges in 
table 72-7 of IEEE 802.3ap.
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Coefficient Update c_1 hold c_0 hold c_1 dec

The purpose of this test is to verify that the difference in v1, v2, and v3 between 
coefficient updates, falls between the specified values in table 72-7 of IEEE 
802.3ap.

PASS Condition The difference in the coefficient update when c(-1) is decremented to the previous 
state for v1, v2, and v3 are within the specified values.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that the signal is connected and data pattern exists (square 8 pattern).

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Measure v1 – set measurement to measure Voltage Overshoot on the rising 
edge.

5 Measure v2 – set measurement to measure Pulse Top with Pulse width of 50%.

6 Measure v3 – set measurement to measure Voltage Preshoot on the falling 
edge.

7 Save v1, v2, v3 as v1(k-1), v2(k-1), and v3(k-1) values.

8 Pop up to ask user to decrement c(-1). OK pressed.

9 Measure v1 – set measurement to measure Voltage Overshoot on the rising 
edge.

10 Measure v2 – set the measurement to measure Pulse Top with Pulse width of 
50%.

11 Measure v3 – set measurement to measure Voltage Preshoot on the falling 
edge.

12 Subtract v1(k) – v1(k-1), v2(k)-v2(k-1), and v3(k)-v3(k-1).

13 Compare and report the values from step 12 to their respective value ranges in 
table 72-7 of IEEE 802.3ap.
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8 Transmitter Output Waveform 
- Coefficient Status 
Measurements

Coefficient Status c_1 dis c_0 min c_1 dis / 69
Coefficient Status c_1 dis c_0 max c_1 dis / 70
Coefficient Status c_1 min c_0 min c_1 dis / 71
Coefficient Status c_1 dis c_0 min c_1 min / 72

This section provides the Methods of Implementation (MOIs) for the Transmitter 
Output Waveform Coefficient Status Measurements using a Keysight Infiniium 
oscilloscope and the D9010EAPC 10GBASE-KR Compliance Test Application.
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Probing and
Connection for the

Bus Signal Level
Tests

You can use any of the oscilloscope channels as the signal source channel. You 
can identify the channels used for the measurement signal in the Configuration tab 
of the 10GBASE-KR and 40GBASE-KR4 Compliance Test Application. (The 
channels shown in the previous figure are just an example.)

Test Procedure 1 Start the automated test application as described in "Starting the 
10GBASE-KR Compliance Test Application" on page 17.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope 
that you have set up in the Configuration tab.

4 In the 10GBASE-KR Test application, click on the Set Up tab.

5 Set up InfiniiSim if needed.

6 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

Figure 14 Probing for Transmitter Output Waveform – Coefficient Status Measurements
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7 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

Figure 15 Selecting Transmitter Output Waveform – Coefficient Status Test

Coefficient Status
Specifications

The 10GBASE-KR and 40GBASE-KR4 specifications can be found in IEEE 802.3ap 
section 72.7.1.11 Table 72-8.

• v2 and v5 (max 40 mV peak-to-peak).

• (v1+v4)/v1, (v2+v5)/v2, and (v3+v6)/v3 shall not exceed 0.05.

• v2 as not defined in table 72-8 <= 40 mV.

Coefficient Status Requirements

c(1) c(0) c(–1) Rpre Rpst v2 (mV)

disabled minimum disabled 0.90 to 1.10 0.90 to 1.10 220 to 330

disabled maximum disabled 0.95 to 1.05 0.95 to 1.05 400 to 600
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minimum minimum disabled — 4.00 (min) —

disabled minimum minimum 1.54 (min) — —

Coefficient Status Requirements

c(1) c(0) c(–1) Rpre Rpst v2 (mV)
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Coefficient Status c_1 dis c_0 min c_1 dis

The purpose of this test is to verify Rpre, Rpst, and v2 are within specification as 
defined in table 72-8 of IEEE 802.3ap. Additionally, to verify that v2 and v5 are 
less than 40 mV. Additionally, (v1+v4)/v1, (v2+v5)/v2, and (v3+v6)/v3 cannot 
exceed 0.05.

PASS Condition Rpre, Rpst, v2, (v1+v4)/v1, (v2+v5)/v2, (v3+v6)/v3, v2 and v5 are within the 
respective defined specifications when c(1) is disabled, c(0) is at its minimum 
value, and c(-1) is disabled.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that the signal is connected and data pattern exists (square 8 pattern).

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Pop up to ask user to change c(0) to minimum. OK pressed.

5 Measure v1 – set measurement to measure Voltage Overshoot on the rising 
edge.

6 Measure v2 – set measurement to measure Pulse Top with Pulse width of 50%.

7 Measure v3 – set measurement to measure Voltage Preshoot on the falling 
edge.

8 Measure v4 – set measurement to measure Voltage Overshoot on the falling 
edge.

9 Measure v5 – set measurement to measure Voltage Base with pulse width of 
50%.

10 Measure v6 – set measurement to measure Voltage Preshoot on the rising 
edge.

11 Calculate Rpre = v3/v2, Rpst = v1/v2, (v1+v4)/v1, (v2+v5)/v2, (v3+v6)/v3.

12 Measure v2 – trigger on rising edge. Scale and center high pulse of the square 
pattern. Place histogram left limit at t1+2T and right limit t2-2T (t1, t2, and T 
defined in IEEE 802.3ap section 72.7.1.11 Figure 72-12).

13 Calculate v2 = v2(max) – v2(min) as measured in step 12 histogram.

14 Measure v5 – trigger on falling edge. Scale and center low pulse of the square 
pattern. Place histogram left limit at t2+2T and right limit t3-2T (t2, t3, and T 
defined in IEEE 802.3ap section 72.7.1.11 Figure 72-12).

15 Calculate v5 = v5(max)-v5(min as measured in step 14 histogram.

16 Compare and report the values from steps 11, 13, and 15 to their respective 
specification values.
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Coefficient Status c_1 dis c_0 max c_1 dis

The purpose of this test is to verify Rpre, Rpst, and v2 are within specification as 
defined in table 72-8 of IEEE 802.3ap. Additionally, to verify that v2 and v5 are 
less than 40 mV. Additionally, (v1+v4)/v1, (v2+v5)/v2, and (v3+v6)/v3 cannot 
exceed 0.05.

PASS Condition Rpre, Rpst, v2, (v1+v4)/v1, (v2+v5)/v2, (v3+v6)/v3, v2 and v5 are within the 
respective defined specifications when c(1) is disabled, c(0) is at its maximum 
value, and c(-1) is disabled.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that the signal is connected and data pattern exists (square 8 pattern).

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Pop up to ask user to change c(0) to maximum. OK pressed.

5 Measure v1 – set measurement to measure Voltage Overshoot on the rising 
edge.

6 Measure v2 – set measurement to measure Pulse Top with Pulse width of 50%.

7 Measure v3 – set measurement to measure Voltage Preshoot on the falling 
edge.

8 Measure v4 – set measurement to measure Voltage Overshoot on the falling 
edge.

9 Measure v5 – set measurement to measure Voltage Base with pulse width of 
50%.

10 Measure v6 – set measurement to measure Voltage Preshoot on the rising 
edge.

11 Calculate Rpre = v3/v2, Rpst = v1/v2, (v1+v4)/v1, (v2+v5)/v2, (v3+v6)/v3.

12 Measure v2 – trigger on rising edge. Scale and center high pulse of the square 
pattern. Place histogram left limit at t1+2T and right limit t2-2T (t1, t2, and T 
defined in IEEE 802.3ap section 72.7.1.11 Figure 72-12).

13 Calculate v2 = v2(max) – v2(min) as measured in step 12 histogram.

14 Measure v5 – trigger on falling edge. Scale and center low pulse of the square 
pattern. Place histogram left limit at t2+2T and right limit t3-2T (t2, t3, and T 
defined in IEEE 802.3ap section 72.7.1.11 Figure 72-12).

15 Calculate v5 = v5(max)-v5(min as measured in step 14 histogram.

16 Compare and report the values from steps 11, 13, and 15 to their respective 
specification values.
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Coefficient Status c_1 min c_0 min c_1 dis

The purpose of this test is to verify Rpst and v2 are within specification as defined 
in table 72-8 of IEEE 802.3ap. Additionally, to verify that v2 and v5 are less than 
40 mV. Additionally, (v1+v4)/v1, (v2+v5)/v2, and (v3+v6)/v3 cannot exceed 0.05.

PASS Condition Rpst, v2, (v1+v4)/v1, (v2+v5)/v2, (v3+v6)/v3, v2 and v5 are within the respective 
defined specifications when c(1) is at its minimum, c(0) is at its minimum value, 
and c(-1) is disabled.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that the signal is connected and data pattern exists (square 8 pattern).

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Pop up to ask user to change c(1) and c(0) to minimum. OK pressed.

5 Measure v1 – set measurement to measure Voltage Overshoot on the rising 
edge.

6 Measure v2 – set measurement to measure Pulse Top with Pulse width of 50%.

7 Measure v3 – set measurement to measure Voltage Preshoot on the falling 
edge.

8 Measure v4 – set measurement to measure Voltage Overshoot on the falling 
edge.

9 Measure v5 – set measurement to measure Voltage Base with pulse width of 
50%.

10 Measure v6 – set measurement to measure Voltage Preshoot on the rising 
edge.

11 Calculate Rpst = v1/v2, (v1+v4)/v1, (v2+v5)/v2, (v3+v6)/v3.

12 Measure v2 – trigger on rising edge. Scale and center high pulse of the square 
pattern. Place histogram left limit at t1+2T and right limit t2-2T (t1, t2, and T 
defined in IEEE 802.3ap section 72.7.1.11 Figure 72-12).

13 Calculate v2 = v2(max) – v2(min) as measured in step 12 histogram.

14 Measure v5 – trigger on falling edge. Scale and center low pulse of the square 
pattern. Place histogram left limit at t2+2T and right limit t3-2T (t2, t3, and T 
defined in IEEE 802.3ap section 72.7.1.11 Figure 72-12).

15 Calculate v5 = v5(max)-v5(min as measured in step 14 histogram.

16 Compare and report the values from steps 11, 13, and 15 to their respective 
specification values.
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Coefficient Status c_1 dis c_0 min c_1 min

The purpose of this test is to verify Rpre and v2 are within specification as defined 
in table 72-8 of IEEE 802.3ap. Additionally, to verify that v2 and v5 are less than 
40 mV. Additionally, (v1+v4)/v1, (v2+v5)/v2, and (v3+v6)/v3 cannot exceed 0.05.

PASS Condition Rpre, v2, (v1+v4)/v1, (v2+v5)/v2, (v3+v6)/v3, v2 and v5 are within the respective 
defined specifications when c(0) is at its minimum, c(-1) is at its minimum value, 
and c(-1) is disabled.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that the signal is connected and data pattern exists (square 8 pattern).

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Pop up to ask user to change c(0) and c(-1) to minimum. OK pressed.

5 Measure v1 – set measurement to measure Voltage Overshoot on the rising 
edge.

6 Measure v2 – set measurement to measure Pulse Top with Pulse width of 50%.

7 Measure v3 – set measurement to measure Voltage Preshoot on the falling 
edge.

8 Measure v4 – set measurement to measure Voltage Overshoot on the falling 
edge.

9 Measure v5 – set measurement to measure Voltage Base with pulse width of 
50%.

10 Measure v6 – set measurement to measure Voltage Preshoot on the rising 
edge.

11 Calculate Rpre = v3/v2, (v1+v4)/v1, (v2+v5)/v2, (v3+v6)/v3.

12 Measure v2 – trigger on rising edge. Scale and center high pulse of the square 
pattern. Place histogram left limit at t1+2T and right limit t2-2T (t1, t2, and T 
defined in IEEE 802.3ap section 72.7.1.11 Figure 72-12).

13 Calculate v2 = v2(max) – v2(min) as measured in step 12 histogram.

14 Measure v5 – trigger on falling edge. Scale and center low pulse of the square 
pattern. Place histogram left limit at t2+2T and right limit t3-2T (t2, t3, and T 
defined in IEEE 802.3ap section 72.7.1.11 Figure 72-12).

15 Calculate v5 = v5(max)-v5(min as measured in step 14 histogram.

16 Compare and report the values from steps 11, 13, and 15 to their respective 
specification values.
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Transmitter Output Waveform “Information Only” Measurements / 76

This section provides the Methods of Implementation (MOIs) for the Transmitter 
Output Waveform “Information Only” Measurements using a Keysight Infiniium 
oscilloscope and the D9010EAPC 10GBASE-KR Compliance Test Application.
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Probing and
Connection for the

Bus Signal Level
Tests

You can use any of the oscilloscope channels as the signal source channel. You 
can identify the channels used for the measurement signal in the Configuration tab 
of the 10GBASE-KR Compliance Test Application. (The channels shown in the 
previous figure are just an example.)

Test Procedure 1 Start the automated test application as described in "Starting the 
10GBASE-KR Compliance Test Application" on page 17.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope 
that you have set up in the Configuration tab.

4 In the 10GBASE-KR Test application, click on the Set Up tab.

5 Set up InfiniiSim if needed.

6 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

7 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

Figure 16 Probing for Transmitter Output Waveform Manual Measurements
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Figure 17 Selecting Transmitter Output Waveform Manual Test

Manual
Measurement
Specifications

These tests are information only tests to show the values of v1..v6, v2, v5, Rpre, 
and Rpst at any status, update, etc., that you would like to measure.
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Transmitter Output Waveform “Information Only” Measurements

The purpose of these tests is information only, to show the values of v1..v6, v2, 
v5, Rpre, and Rpst at any status, update, etc., that you would like to measure.

PASS Condition Information only. No pass/fail criteria.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that the signal is connected and data pattern exists (square 8 pattern).

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Measure v1 – set measurement to measure Voltage Overshoot on the rising 
edge.

5 Measure v2 – set measurement to measure Pulse Top with Pulse width of 50%.

6 Measure v3 – set measurement to measure Voltage Preshoot on the falling 
edge.

7 Measure v4 – set measurement to measure Voltage Overshoot on the falling 
edge.

8 Measure v5 – set measurement to measure Voltage Base with pulse width of 
50%.

9 Measure v6 – set measurement to measure Voltage Preshoot on the rising 
edge.

10 Calculate Rpre = v3/v2, Rpst = v1/v2.

11 Measure v2 – trigger on rising edge. Scale and center high pulse of the square 
pattern. Place histogram left limit at t1+2T and right limit t2-2T (t1, t2, and T 
defined in IEEE 802.3ap section 72.7.1.11 Figure 72-12).

12 Calculate v2 = v2(max) – v2(min) as measured in step 12 histogram.

13 Measure v5 – trigger on falling edge. Scale and center low pulse of the square 
pattern. Place histogram left limit at t2+2T and right limit t3-2T (t2, t3, and T 
defined in IEEE 802.3ap section 72.7.1.11 Figure 72-12).

14 Calculate v5 = v5(max)-v5(min as measured in step 14 histogram.

15 Report the values from steps 11, 13, and 15.
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DME Differential Peak-to-Peak Output Voltage Test / 81
DME T1-Transition Position Spacing (Period) Test / 82
DME T2-Clock Transition to Clock Transition Test / 83
DME T3-Clock Transition to Data Transition Test / 84
EEE Differential Peak-to-Peak Output Voltage Test with TX Disabled / 85
EEE Differential Peak-to-Peak Output Voltage Test / 86
EEE Common Mode Deviation Voltage Test / 87

This section provides the Methods of Implementation (MOIs) for the DME and EEE 
Waveform Measurements using a Keysight Infiniium oscilloscope and the 
D9010EAPC 10GBASE-KR Compliance Test Application.
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Probing and
Connection for the

Bus Signal Level
Tests.

Figure 18 Probing for DME/EEE Waveform Measurements
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You can use any of the oscilloscope channels as the signal source channel. You 
can identify the channels used for the measurement signal in the Configuration tab 
of the 10GBASE-KR Compliance Test Application. (The channels shown in the 
previous figure are just an example.)

Test Procedure 1 Start the automated test application as described in "Starting the 
10GBASE-KR Compliance Test Application" on page 17.

2 Connect the probes to the signals on the DUT.

3 Connect the oscilloscope probes or cables to the channel(s) of the oscilloscope 
that you have set up in the Configuration tab.

4 In the 10GBASE-KR Test application, click on the Set Up tab.

5 Set up InfiniiSim if needed.

6 Type in or select the Device Identifier as well as the User Description from the 
drop-down list. Enter your comments in the Comments text box.

7 Click the Select Tests tab and check the tests you want to run. Check the parent 
node or group to check all the available tests within the group.

Figure 19 Selecting DME/EEE Waveform Tests
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DME/EEE
Waveform

Specifications

The 10GBASE-KR and 40GBASE-KR4 DME specifications can be found in IEEE 
802.3ap section 73.5.1 Table 73-1 and section 73.5.3 Table 73-2. The 
10GBASE-KR and 40GBASE-KR4 EEE specifications can be found in section 
72.7.1 Table 72-6.

• DME Differential Peak-to-Peak Output Voltage (0.6-1.2 V).

• DME T1 (3.2 ns-0.01% to 3.2 ns+0.1%).

• DME T2 (6.2 ns-6.6 ns).

• DME T3 (3.0 ns-3.4 ns).

• EEE Differential Peak-to-Peak Output Voltage with TX disabled (max 30 mV).

• EEE Differential Peak-to-Peak Output Voltage with TX enabled (min 720 mV).

• EEE Common Mode Voltage Deviation (±150 mV).
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DME Differential Peak-to-Peak Output Voltage Test

The purpose of this test is to verify that the peak-to-peak voltage of the differential 
signal on a 1010 pattern is less than 1200 mV.

PASS Condition The differential signal max peak-to-peak voltage on a 1010 pattern is less than 
1200 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal is connected and has a 1010 pattern.

3 Measure the peak-to-peak voltage of the differential signal of DUT+ and DUT-.

4 Compare the min and max peak-to-peak voltage to be within 0.6 to 1.2 V.
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DME T1-Transition Position Spacing (Period) Test

The purpose of this test is to verify that transition spacing of the DME signal is 
3.2 ns ±0.01%.

PASS Condition The mean period is between 3.2 ns ±0.01%.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal is connected.

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Request DUT in DME mode.

5 Measure the unit interval of the differential DME signal – set UI measurement to 
SEMI, 3.2e-9.

6 Compare the mean measurement to 3.2 ns ±0.01%.
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DME T2-Clock Transition to Clock Transition Test

The purpose of this test is to verify clock to clock transition is 6.2 ns to 6.6 ns.

PASS Condition The mean period is between 6.2 ns to 6.6 ns.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal is connected.

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Request DUT in DME mode.

5 Measure the rising to rising edge.

6 Compare the min and max values to measurement to 6.2 ns to 6.6 ns.
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DME T3-Clock Transition to Data Transition Test

The purpose of this test is to verify clock to data transition is 3.0 ns to 3.4 ns.

PASS Condition The min and max UI time is between 3.0 ns to 3.4 ns.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal is connected.

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Request DUT in DME mode.

5 Measure the unit interval of the differential DME signal – set UI measurement to 
SEMI, 3.2e-9.

6 Compare the min and max values to measurement to 3.0 ns to 3.4 ns.
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EEE Differential Peak-to-Peak Output Voltage Test with TX Disabled

The purpose of this test is to verify that when TX is disabled the peak-to-peak 
voltage is less than 30 mV.

PASS Condition The max peak-to-peak voltage is less than 30 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Request DUT to be EEE mode.

3 Check that the signal is truly with TX disabled (no valid data transitions).

4 Measure peak-to-peak voltage of the signal.

5 Compare the max peak-to-peak voltage to 30 mV.
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EEE Differential Peak-to-Peak Output Voltage Test

The purpose of this test is to verify that the peak-to-peak voltage of the differential 
signal on a 1010 pattern is greater or equal to 720 mV.

PASS Condition The differential signal max peak-to-peak voltage on a 1010 pattern is greater than 
or equal to 720 mV.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Request DUT in EEE mode.

3 Verify that there is a signal is connected and has a 1010 pattern.

4 Measure the peak-to-peak voltage of the differential signal of DUT+ and DUT-.

5 Compare the min voltage to be greater than or equal to 720 mV.
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EEE Common Mode Deviation Voltage Test

The purpose of this test is to verify that the common mode signal of the differential 
pair of the pre-LPI signal and the LPI signal is within ±150 mV.

PASS Condition The signal voltage change between pre and post LPI is within 150 mV change.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal and that the connection is dual-single ended.

3 Request DUT to be pre-LPI.

4 Measure the peak-to-peak voltage of the addition of the channel 1 and 3 or 
channel 2 and 4.

5 Request DUT to be in LPI.

6 Measure the peak-to-peak voltage of the addition of the channel1 and 3 or 
channel 2 and 4.

7 Calculate Vpp(post)-Vpp(pre).

8 Compare the result from step 8 to ±150 mV.
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Debug mode can be selected to enable the ability to change jitter measurement 
options. In the Configuration tab, select the Debug radio button. This will add the 
following options:

• Rj Bandwidth — Choose the Rj Filter. Options are Narrow (Pink) or Wide (White). 
This changes the amount of DC jitter in the Rj measurement.

• Jitter Pattern Length — Choose Periodic or Arbitrary. Periodic is used for data 
patterns that are periodic and repeat through the scope memory. Arbitrary is 
used for random data patterns or long data patterns (for example, PRBS31) 
that do not repeat through the scope memory. If Arbitrary is selected, set the ISI 
filters.

• ISI Filter Lead — When using Arbitrary mode for the Jitter Pattern Length, set the 
Leading ISI filter coefficient. To help select the correct ISI filter, see 
"Application Note 1574: Choosing the ISI Filter Size for EZJIT Plus Arbitrary 
Data Jitter Analysis" (at www.keysight.com, literature part number 
5989-4974EN).

• ISI Filter Lag — When using Arbitrary mode for the Jitter Pattern Length, set the 
Lagging ISI filter coefficient. Again, to help select the correct ISI filter, see 
"Application Note 1574: Choosing the ISI Filter Size for EZJIT Plus Arbitrary 
Data Jitter Analysis".

http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
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Exporting Measurement Results to Repository / 92

This section describes the Upload Measurement Results To Repository feature of 
the Keysight D9010EAPC 10GBASE-KR and 40GBASE-KR4 Compliance Test 
Application.
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Exporting Measurement Results to Repository

The Upload Results To Repository feature is an add-on to the Keysight Test 
Application, where it expands the boundaries of storing and analyzing the 
measurement results to a wider audience, who may be based in multiple sites 
across various geographical locations. Along with the feature of exporting test 
results from the Test Application into your local disk in a CSV or HTML file format, 
you have the option to upload the test results to a Dataset on a Web Repository. 
Based on your requirements, you may either upload only a single measurement 
trial or upload huge volumes of measurement results to any Dataset.

Not only can remote users with an active Internet connection access these 
Datasets and the corresponding test results on the Web Repository, but they have 
the option to add and delete Datasets on the Web Server. In the Upload Results 
To Repository feature, you can even modify the Dataset properties, which are 
helpful especially when performing a graphical analysis of the uploaded data.

In combination with the Keysight KS6800A Series Analytics Software, the Upload 
Results To Repository feature provides a comprehensive solution to export, view 
and perform analysis of the measurement results, thereby resulting in qualitative 
data to ensure that the Device Under Test (DUT) is compliant to the industry 
standards.

Refer to the Keysight KS6800A Series Analytics Software Online Help for more 
information about the functionality of various features in this software.

To export measurement results to the Repository after the completion of test runs,

1 From the Test Application’s main menu, click File > Export Results... > Repository.

The Upload Results to Repository window appears.

2 In the Connect to Server pane of the Datasets tab, click Connect... to login to the 
Dataset Repository server.
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 3 In the URL: drop-down text field that appears, replace the default text with the 
actual IP address or the URL along with the port number, if applicable.

You may enter the URL of the Web Repository server, which may be a 
self-hosted server on your machine (http://localhost:5000/), a remote server or 
an authentication server. Note that all such URLs accessed via this window 
appear as a drop-down list in the URL: field.

4 Click the Check button to verify that the KS6800A Series Analytics service is 
available on the specified web address. Repeat this step each time you edit the 
web address.
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• For unrestricted access to the Repository

a If the server does not require authentication and the KS6800A Series 
Analytics service is found on the specified web address, the version 
information is displayed adjacent to the Check button.

b If you click OK, the Upload Results to Repository window displays the 
connectivity status to the Dataset Repository.

c Click Browse... to navigate directly to the URL.

• For restricted access to the Repository

a If service is found on the specified URL but access to the web server is 
restricted based on authentication, the version information is displayed 
along with the text Authentication Required adjacent to the Check button. 
Also, the Username: and Password: fields appear. The OK button remains 
disabled until the authentication credentials are entered.

b Enter the user credentials in the respective fields, which are required for 
authentication to access those Datasets that have been created on the web 
server you are connecting to. For each URL that you access, the Username: 
drop-down box keeps a record and displays all user names used to access 
the respective URL.
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c Click OK to connect to the entered URL/IP address.

The Connect to Server area displays the connection status along with the 
username.

d Click Browse... to navigate directly to the URL.

5 In the Select Dataset area, click Select... to view the list of Datasets created on 
the connected repository. Click Refresh to update the list of Datasets that 
appear in the Test Application's user interface.

6 Select the Dataset name where you wish to upload measurement results to. 
Click OK.
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 The Select Dataset area displays the selected Dataset as Active. The 

Measurements and Properties tabs are enabled after a Dataset is selected.
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 7 Click the Measurements tab where the test results from the last test run are 
displayed.

8 You may select and export multiple test results to the repository. You may 
change the format for the display of measurement data using the drop-down 
options in the Group by: field.
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9 After selecting one or more measurements, either click Upload or switch to the 
Properties tab to associate one or more properties to the measurements that are 
being uploaded to the Web Server.

To perform an enhanced analysis on the measurement data using the KS6800A 
Series Analytics Service Software, Keysight recommends assigning properties 
to the measurements.
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10 Click the Properties tab to assign properties for your measurement results that 
you select to upload. By default, the App-Defined properties are selected to be 
uploaded in association with the measurement data, wherein only certain 
aspects of the selected measurements are uploaded. However, you may switch 
to Globals to include as properties one or more options configured under the 
rest of the tabs of the Compliance Test Application or define one or more 
custom property values to be associated with the selected measurement data.
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11 Click Upload to begin uploading measurement results.

12 Click Close to exit the Upload Results to Repository window and to return to the 
Compliance Test Application.

You may access the Dataset Repository using the Internet browser on your 
machine to view the measurement results graphically on the KS6800A Series 
Analytics Service Software.

KS6800A Series Analytics Service Software

The KS6800A Series Analytics Service software supports multiple data sources 
and also a wide range of data import clients. This web-based software provides 
various types of charts, such as Histogram, Box-and-Whisker, Line, Scatter, Eye 
Diagram and Constellation, each with split capability to enable data analysis. Once 
you upload the measurement results to a Dataset on the KS6800A Series Analytics 
Service Software via the Upload Results to Repository window of the Test Application, 
the measurement results can be viewed graphically as shown below:
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For more information on the Data Analytics Web Service Software, visit KS6800A 
Series Analytics Service Software page on the Keysight website. You may refer to 
the Help manual provided within the software to understand the functionality of its 
features.

https://www.keysight.com/en/pd-2976519-pn-KS6800A/data-analytics-software?nid=-32976.1259666&cc=US&lc=eng
http://www.keysight.com/en/pd-2747984-pn-N8844A/data-analytics-web-service-software?cc=US&lc=eng
https://www.keysight.com/en/pd-2976519-pn-KS6800A/data-analytics-software?nid=-32976.1259666&cc=US&lc=eng
https://www.keysight.com/en/pd-2976519-pn-KS6800A/data-analytics-software?nid=-32976.1259666&cc=US&lc=eng


102 Keysight D9010EAPC 10GBASE-KR and 40GBASE-KR4 Compliance Test Application

12 Exporting Measurement Results to Repository
 



103

 

Keysight D9010EAPC 10GBASE-KR and 40GBASE-KR4 Compliance Test Application 
Methods of Implementation

A Calibrating the Infiniium 
Oscilloscope and Probe

Oscilloscope Internal Calibration / 104
Probe Calibration / 109

This section describes the Keysight Infiniium digital storage oscilloscope 
calibration procedures.
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Oscilloscope Internal Calibration

This will perform an internal diagnostic and calibration cycle for the oscilloscope. 
For the Keysight oscilloscope, this is referred to as Calibration.

Required Equipment for Oscilloscope Calibration

To calibrate the Infiniium oscilloscope in preparation for running the 10GBASE-KR 
and 40GBASE-KR4 automated tests, you need the following equipment:

• Keyboard, qty = 1, (provided with the Keysight Infiniium oscilloscope).

• Mouse, qty = 1, (provided with the Keysight Infiniium oscilloscope).

• Precision 3.5 mm BNC to SMA male adapter, Keysight p/n 54855-67604, 
qty = 2 (provided with the Keysight Infiniium oscilloscope).

• Calibration cable (provided with Keysight Infiniium oscilloscopes). Use a good 
quality 50  BNC cable.

• BNC shorting cap.

Figure 20 Accessories Provided with the Keysight Infiniium Oscilloscope

BNC
Shorting Cap
(Used to calibrate
54850A series
oscilloscopes)

Precision 3.5 mm Adapters (2)

Calibration Cable
(Used to calibrate 54850A,
Keysight Infiniium
oscilloscopes)
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Running the Oscilloscope Internal Calibration

This Calibration will take about 20 minutes. Perform the following steps:

1 Set up the oscilloscope with the following steps:

a Connect the keyboard, mouse, and power cord to the rear of the 
oscilloscope.

b Plug in the power cord.

c Turn on the oscilloscope by pressing the power button located on the lower 
left of the front panel.

d Allow the oscilloscope to warm up at least 30 minutes prior to starting the 
calibration procedure in step 3 below.

2 Locate and prepare the accessories that will be required for the internal 
calibration:

a Locate the BNC shorting cap.

b Locate the calibration cable.

c Locate the two Keysight precision SMA/BNC adapters.

d Attach one SMA adapter to the other end of the calibration cable - hand 
tighten snugly.

e Attach another SMA adapter to the other end of the calibration cable - hand 
tighten snugly.
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3 Referring to the following figure, perform the following steps:

a Click the Utilities > Calibration... menu to open the Calibration dialog box.

4 Referring to the following figure, perform the following steps to start the 
calibration:

Figure 21 Accessing the Calibration Menu
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a Uncheck the Cal Memory Protect checkbox.

b Click the Start button to begin the calibration.

c During the calibration of channel 1, if you are prompted to perform a Time 
Scale Calibration, as shown in the following figure, click the Std+Dflt button to 
continue the calibration, using the Factory default calibration factors.

Figure 22 Oscilloscope Calibration Window
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d When the calibration procedure is complete, you will be prompted with a 
Calibration Complete message window. Click the OK button to close this 
window.

e Confirm that the Vertical and Trigger Calibration Status for all Channels 
passed.

f Click the Close button to close the calibration window.

g The internal calibration is completed.

Figure 23 Time Scale Calibration Dialog Box

NOTE These steps do not need to be performed every time a test is run. However, if the ambient 
temperature changes more than 5 degrees Celsius from the calibration temperature, this 
calibration should be performed again. The delta between the calibration temperature and the 
present operating temperature is shown in the Utilities > Calibration... menu.
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Probe Calibration

Before performing 10GBASE-KR and 40GBASE-KR4 tests, you should calibrate 
the probes. Calibration of the solder-in probe heads consist of a vertical calibration 
and a skew calibration. The vertical calibration should be performed before the 
skew calibration. Both calibrations should be performed for best probe 
measurement performance.

Required Equipment for Probe Calibration

The calibration procedure requires the following parts.

• BNC (male) to SMA (male) adapter.

• Deskew fixture.

• 50  SMA terminator.

Connecting the Probe for Calibration

For the following procedure, refer to the following figure.
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1 Connect BNC (male) to SMA (male) adapter to the deskew fixture on the 
connector closest to the yellow pincher.

2 Connect the 50  SMA terminator to the connector farthest from yellow 
pincher.

Figure 24 Solder-in Probe Head Calibration Connection Example

BNC to SMA
Connector

Pincher

Terminator

Deskew
Fixture
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3 Connect the BNC side of the deskew fixture to the Aux Out BNC of the Infiniium 
oscilloscope.

4 Connect the probe to an oscilloscope channel.

5 To minimize the wear and tear on the probe head, it should be placed on a 
support to relieve the strain on the probe head cables.

6 Push down the back side of the yellow pincher. Insert the probe head resistor 
lead underneath the center of the yellow pincher and over the center conductor 
of the deskew fixture. The negative probe head resistor lead or ground lead 
must be underneath the yellow pincher and over one of the outside copper 
conductors (ground) of the deskew fixture. Make sure that the probe head is 
approximately perpendicular to the deskew fixture.

7 Release the yellow pincher.

Verifying the Connection

1 On the Infiniium oscilloscope, press the [Auto Scale] key on the front panel.

2 Set the volts per division to 100 mV/div.

3 Set the horizontal scale to 1.00 ns/div.

4 Set the horizontal position to approximately 3 ns. You should see a waveform 
similar to that in the following figure.

If you see a waveform similar to that of the following figure, then you have a bad 
connection and should check all of your probe connections.

Figure 25 Good Connection Waveform Example



112 Keysight D9010EAPC 10GBASE-KR and 40GBASE-KR4 Compliance Test Application

A Calibrating the Infiniium Oscilloscope and Probe
 

Figure 26 Bad Connection Waveform Example
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Running the Probe Calibration and Deskew

1 On the Infiniium oscilloscope in the Setup menu, select the channel connected 
to the probe, as shown in the following figure.

2 In the Channel Setup dialog box, select the Probes... button, as shown in the 
following figure.

Figure 27 Channel Setup Window
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3 In the Probe Setup dialog box, select the Calibrate Probe... button.

4 In the Probe Calibration dialog box, select the Calibrated Atten/Offset radio 
button.

5 Select the Start Atten/Offset Calibration... button and follow the on-screen 
instructions for the vertical calibration procedure.

Figure 28 Channel Dialog Box

Figure 29 Probe Setup Window
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6 Once the vertical calibration has successfully completed, select the Calibrated 
Skew... button.

7 Select the Start Skew Calibration... button and follow the on-screen instructions 
for the skew calibration.

At the end of each calibration, the oscilloscope will prompt you if the calibration 
was or was not successful.

Verifying the Probe Calibration

If you have successfully calibrated the probe, it is not necessary to perform this 
verification. However, if you want to verify that the probe was properly calibrated, 
the following procedure will help you verify the calibration.

The calibration procedure requires the following parts:

• BNC (male) to SMA (male) adapter.

• SMA (male) to BNC (female) adapter.

• BNC (male) to BNC (male) 12 inch cable such as the Keysight 8120-1838.

• Keysight 54855-61620 calibration cable (Infiniium oscilloscopes with 
bandwidths of 6 GHz and greater only).

• Keysight 54855-67604 precision 3.5 mm adapters (Infiniium oscilloscopes with 
bandwidths of 6 GHz and greater only).

• Deskew fixture.

For the following procedure, refer to the following figure.

Figure 30 Probe Calibration Window
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1 Connect BNC (male) to SMA (male) adapter to the deskew fixture on the 
connector closest to the yellow pincher.

2 Connect the SMA (male) to BNC (female) to the connector farthest from the 
yellow pincher.

Figure 31 Probe Calibration Verification Connection Example
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3 Connect the BNC (male) to BNC (male) cable to the BNC connector on the 
deskew fixture to one of the unused oscilloscope channels. For infiniium 
oscilloscopes with bandwidths of 6 GHz and greater, use the 54855-61620 
calibration cable and the two 54855-64604 precision 3.5 mm adapters.

4 Connect the BNC side of the deskew fixture to the Aux Out BNC of the Infiniium 
oscilloscope.

5 Connect the probe to an oscilloscope channel.

6 To minimize the wear and tear on the probe head, it should be placed on a 
support to relieve the strain on the probe head cables.

7 Push down on the back side of the yellow pincher. Insert the probe head 
resistor lead underneath the center of the yellow pincher and over the center 
conductor of the deskew fixture. The negative probe head resistor lead or 
ground lead must be underneath the yellow pincher and over one of the outside 
copper conductors (ground) of the deskew fixture. Make sure that the probe 
head is approximately perpendicular to the deskew fixture.

8 Release the yellow pincher.

9 On the oscilloscope, press the autoscale button on the front panel.

10 Select Setup menu and choose the channel connected to the BNC cable from 
the pull-down menu.

11 Select the Probes... button.

12 Select the Configure Probe System button.

13 Select User Defined Probe from the pull-down menu.

14 Select the Calibrate Probe... button.

15 Select the Calibrated Skew radio button.

16 Once the skew calibration is completed, close all dialog boxes.

17 Select the Start Skew Calibration... button and follow the on-screen instructions.

18 Set the vertical scale for the displayed channels to 100 mV/div.

19 Set the horizontal range to 1.00 ns/div.

20 Set the horizontal position to approximately 3 ns.

21 Change the vertical position knobs of both channels until the waveforms 
overlap each other.

22 Select the Setup menu choose Acquisition... from the pull-down menu.

23 In the Acquisition Setup dialog box enable averaging. When you close the 
dialog box, you should see waveforms similar to that in the following figure.
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Figure 32 Calibration Probe Waveform Example

NOTE Each probe is calibrated with the oscilloscope channel to which it is connected. Do not switch 
probes between channels or other oscilloscopes, or it will be necessary to calibrate them 
again. It is recommended that the probes be labeled with the channel on which they were 
calibrated.
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